Installing Richard Burns Rally in 2021

Times are changing and currently the go-to option for new RBR users should be the
Rallysimfans (also known as RSF/HU/Hungarian) plugin. Other plugins such as Czech plugin
and RSRBR still have a major user base but are becoming undeniably outdated and out of
further active development. The guys at RSF have been doing an amazing job with the plugin to
make RBR more user-friendly than what it has ever been in the 16 years of its existence.

Rallysimfans installer includes the original base game with two official patches and every
essential plugin to get you started.

NGPcarmenu by Mika-n: various Ul improvements and customization options

Fixup and NGP by Workerbee: Up-to-date physics and general game features

Pacenote Plugin by Workerbee: allows you to edit pacenotes and camera settings
RBR_RX by JHarro: enables the usage of tracks created with BTB (Bob’s Track Builder)
Gauger plugin by V317MT: ingame dashboard/telemetry thing

RBRVR v1.6 by Keijo “Kegetys” Ruotsalainen: the plugin for VR users

Very short TL;DR for the people who can’t be bothered to read this whole document
properly or believe they can do without, here is what you need to do:
1. Download installer at http://www.rallysimfans.hu/rbr/download.php?download=rsfrbr
2. Make a driver account at the website
3. Run the installer and choose what you want for
a. Base game (essential, never leave this unchecked)
b. Plugins (all are recommended except RBRVR plugin if you’re not a VR user)
c. Stages (choose less if you don’t have enough disk space)
d. Additional options on the next page
4. Run the game from RichardBurnsRally_SSE.exe.
5. Drive in the rallysimfans.hu plugin (Online rally, Hotlap rank, Practice)

How to install

First of all, you will not need an existing base game. If you have an existing RBR install don'’t
even think about trying to install RSF plugin into the same folder.

Go to hitp://www.rallysimfans.hu/rbr/index.php and find the newest installer .exe on the front
page. As of September 2021, the newest version is Rallysimfans_Installer_v1.14. First thing the
installer will ask is where to install. Do not install into the following locations:
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C: \Program Files\
C:\Program Files (x86)\
C:\Users\Your name\
C:\Program\

Desktop

NOTE: many antivirus programs are falsely detecting and quarantining some of the files. Make
sure your antivirus programs are disabled before continuing further. A good tip is also to add the
whole RBR folder into your Windows Defender exceptions. This will make the game boot much
faster as it's not scanning the files every time.

e Create a folder called “Richard Burns Rally HU” or similar.
e Select full installation

The download size is about 13 GB. When extracted, the game takes about 85-90 GB of space.
Make sure you have enough space on the drive you’re installing to. Most of the size comes from
the ~400 or so modded stages so if you just want to try the game first without all content, feel
free to leave most of the Maps out of the install. The vanilla game tracks are still some of the
best, and good enough for the average once-a-week player. They are included with the base
game so even if you decide to leave all Maps out from the install, you will still have about 40
stages.

Installation Size download (extracted) Total price
Minimal install (base game) <2 GB (4 GB) 0 €/$/£
Only original stages and <3GB (10 GB) 0 €/$/£
modded

cars+physics+sounds

Everything (recommended) 13-14 GB (85-90 GB) 0 €/$/£

Do not choose the Hungarian pacenote options if you do not speak Hungarian, that has caused
a lot of confusion for players. Choose the “Original English navigator sound” and you can
always change it later for a more advanced one from outside the installer.

On the next “additional tasks” page, it is recommended to check every single checkbox except
the Adaptive Force Feedback (known to cause FPS issues). Make sure to scroll down to check
the DirectX installation as for some reason it is not checked by default and is very important to
have.

Click next and it will take you to a summary page. If you're happy with the settings, click install.
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Now, the installer is known to occasionally freeze for an undetermined amount of time
depending on the server load. If it does, keep calm and wait. It will continue automatically when
the queue clears up.

If you've done everything correctly, you should now have a working RBR Rallysimfans install..
Now you are ready to run the game from RichardBurnsRally_SSE.exe or the desktop
shortcut that was created.

NOTE: If your game doesn’t start even after that, you will need to
1) Run it as an administrator
2) Add it to DEP exceptions
Quote from Vauhtimurot blog: “Type sysdm.cpl (.cpl refers to Control Panel) in the
Windows search box and run it — On the Advanced tab go to Performance settings —
Data Execution Prevention tab (check Turn on DEP for all programs and services except
those | select and add RichardBurnsRally_SSE.exe to the list.”

This step will solve about 99% or launching problems. If it doesn’t, there is something very major
wrong with the installation (see FAQ).

Inside RBR

When you start RBR for the first time, it should skip some of the original menus to the
rallysimfans plugin straight away. If it doesn’'t and you see the main menu, navigate to Options
-> Plugins -> rallysimfans.hu to play the game. The traditional Quick Rally, Rally School and
Rally Season game modes are NOT playable without little tweaks we’re not gonna explain in
this tutorial.

Now, there are three game modes in RSF: Online Rally, Time Trial (Hotlap rank) and
Practice.
They are pretty much self explanatory, so we’ll not go deeper with this topic.

One of the main features in RSF that is superior to any RBR mod in the past is the car
management. In RSF, all cars (as of right now there are 85 NGP6 physics cars) are always
available without restarting the game. The traditional RBR 8 “car slots” can be forgotten forever.
One feature not many people realise at first is that on the stage and car selections, you can
press enter to get to the bigger selection screen, instead of scrolling through them one by one.

Cars, physics, sounds and default setups are downloaded from the server automatically when
you enter a stage for the first time with said car. One thing that might annoy some people is the
low quality of default car liveries. This is an intentional feature to speed up the car download.
You are free to download better skins from the internet or make your own.
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NOTE: Useful tip for users with an existing CZ installation, you can copy and paste the
whole Cars folder to HU installation. This way you don’t have to set camera angles and
skins again.

You do not need RBRCIT or any other external car installation tools with RSF.

Control bindings should be done from the main menu/options/controls page. Navigate to the
main menu by pressing ESC when you are in Rallysimfans.hu plugin. If you do them when on
stage, they might not be saved properly. If you see the control axis of
throttle/brake/clutch/handbrake is inverted, find input.ini in the main folder and change the axis
value from false to true. Once you are happy with the control bindings, back out to the main
menu and the game will ask you to save the profile.

Most common settings options

RSF Launcher by Mika-n is the recommended tool to tweak settings for the game. Run it from:
main folder/rsf_launcher/RSF_Launcher.exe or a desktop shortcut was created when you
installed the game. The Launcher has almost every setting you might want to change in easy
checkbox or dropdown list format.
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# RSF Launcher

Launch RER
Virtual Reality

Screen & Graphics

1920x1080 ~ Resolution

SETTINGS Normal Fullscreen mode

RallySimFans Default * RER gaming monitor

Vertical sync (VSYNC) Show FPS counter
My Pacenotes

e Graphics quality Custom -

Cockpit S Dashboard Off = Cubic environment maps

Controls ~ Render quality

Tips & Docs Off = Particle quality

ADVANCED Render car shadows

Telemetry
Virtual Reality settings

Plugins
Use Virtual Reality headset

Disable camera shake in ¥R
Disable GaugerPlugin automatically in VR mode
Override resolution in VR mode

. 125 % VR render scalin
® Advanced options = i 9

If you still want to do it manually, the most common settings you are located in
RBRHU/Plugins/Fixup.ini and RBRHU/richardburnsrally.ini.

How to register to race online

e Go to the website of the plugin (https://rallysimfans.hu/rbr/index.php) and click register.
You will be guided to the forum. It's Hungarian by default but you can change it to
English in the top right corner.

Agree the terms and conditions.
Fill in the required things (your username, an email address and your password) and
submit.

e You will receive an email where you can activate your account.

Once this is complete, you can now open the game and go to either “online rally” or “hotlap”
where it will ask you for a username and a password. These are the same ones you filled in
while registering. Enter those and you are good to go.
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If you want to automatically log in, be sure to go to > options > Plugins > Rallysimfans.hu >
Options > Tick the box that says “Auto login”.

How to update your installation

One of the greatest features of RSF is that all updates regarding cars, physics and sounds are
automatic. For these, you don’t have to do anything. For larger plugin updates such as when
new features or new stages are released, a new installer will be published. Run that like you did
when you installed the game and choose “update installation” on the first page. It should
automatically have the checkbox marked on all new content, but you should take a look
yourself.

To be more clear, RSF may have two kinds of updates and this is how those are updated:

(1) Rallysimfans or other "must-have" plugin updates. There is no need to run installer to update
these. All it takes is to start RBR as usual and RSF will automatically update required plugins if
necessary (top left corner shows a small downloading window). Also, new FMOD audio files or
cars are also automatically updated by RSF plugin, so no need to manually download those via
installer.

(2) New maps. This one requires to run the RSF installer app because RSF plugin doesn't
download maps automatically. If there is no new RSF installer version then simply re-run the
one you already have (or if in doubt then check the web site and download the latest rsf
installer).

FAQ - Frequently asked questions and answers

If you experience weird problems with the game, first of all make sure you didn't install it in
these folders:

- C:\ Program Files \

- C:\ Program Files (x86) \

- C:\ Users \ Your Account Name \

- C:\ Program

- Desktop

Q: My game doesn't start

A: First, run the installer in “Modify settings” mode. If that doesn't work, DEP settings will.
Quote from Vauhtimurot troubleshooting:
https://vauhtimurot.blogspot.com/p/troubleshooting.html#GameDoesntLaunch
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“The DEP settings: Type sysdm.cpl (.cpl refers to Control Panel) in the Windows search box and
run it — On the Advanced tab go to Performance settings — Data Execution Prevention tab
(check Turn on DEP for all programs and services except those | select and add
RichardBurnsRally_SSE.exe to the list.) “

One very rare case of game not starting might be due to the Gauger plugin, so if nothing else
has fixed it try to disable the Gaugerplugin from the RSF Launcher.

Q: How do | set up wheel and pedals?
A:_https://vauhtimurot.blogspot.com/p/setting-up-your-wheel.html

Q: My controls don't save

A: Change them in the main options menu (back out from RSF plugin) and back out to the main
menu. It will ask you to save the options If you change them while in stage they might not save
properly. If they are still not saved, delete the pfPROFILENAME.acm file from your
SavedGames folder. Set controls in-game once more and make that file read-only.

Q: | accidentally installed Hungarian codriver, how do | change it?

A: Run the most recent installer and leave the checkmark only on Pacenote plugin (Workerbee)
and Original English codriver. You can install whatever codriver you find on the internet, but the
original is enough for most beginners.

Q: How to change FOV and other camera settings?

A: Double click right on stage and a window will pop up. More here:
https://vauhtimurot.blogspot.com/p/editing-cameras.html

TIP! You can set up a common FOV for all cars in RSF Launcher or Plugins/NGPcarmenu.ini file

Q: How to hide the steering wheel / windscreen / wipers?
A: RSF Launcher has an option for these.

Q: My pedals / handbrake are inverted
A: Change the inverted values true/false in input.ini in the main folder or use the RSF Launcher.

Q: How do | disable the gauger plugin?

A:

The default gauger takes up a lot of screen space and it is quite annoying.

Go to main menu > options > plugins > gauger plugin and select disable

It is also possible to mod the configuration file however you want it to look like. RSF Launcher
has many options for different gauger layouts.

Q: | can't see any modded cars/stages

A: You should always drive in the rallysimfans.hu plugin. You can navigate there from the main
menu by going options -> plugins -> rallysimfans.hu. Quick rally and Rally School game modes
don't work properly without tweaking some other things.
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Q: How do | get the new content?

A: Cars, sounds and physics are updated automatically. There will be a notification in the
Discord server whenever something new gets released. For new stages, download a new
installer and choose only the new content you want to download.

Q: How to change ingame wheel animation rotation?
A: RSF Launcher has an option for this in the “Cockpit & Dashboard” page.

Q: How do Il install new liveries for the cars?
A: Download the livery and overwrite the files in RBR/Cars/YOUR CAR/textures/ folder. Find
skins for example here:_http://rbrplus.blogspot.com/

Q: The game resolution is not right/it looks like the menus are “zoomed in”
A:
Make sure the XRes and YRes are correct in the richardburnsrally.ini file
Make sure your Windows scaling is set at 100%
OR
e Right click on RichardBurnsRally_sse.exe -> properties tab -> compatibility tab -> click
“Modify high DPI scaling options”
e Set “Override high DPI scaling behavior” option and choose “Application” instead of
System scaling value

Q: RallySchool doesn't work. The game crashes or a car is stuck at neutral and 1st gear

in RallySchool, QuickRally or in RBR_RX

A: The original RBR cars don't work with the newer NGP6 physics made by WorkerBee.

RallySimFans plugin (=RSF) uses NGP6 physics. If you really really really want to use

RallySchool, QuickRally or RBR_RX menus then you need to
e (0)in rallysimfans options the “Restore cars” option needs to be unchecked

(1) download RBRCIT tool from github.com/zissakos/RBRCIT/releases,

(2) unpack the RBRCIT_v1.2.0.zip file on the root folder of RBR installation,

(3) run RBRCIT.EXE app,

(4) Choose "Download / Update carlist.ini" menu command,

(5) Use the tool to install NGP6 cars into slots 0-7 shown in InstalledCars list on the top

right corner in RBRCIT tool. Choose any of the custom cars from the list on the left

(press download link in model, physics and FMOD cells if this is the first time you use the

tool).

e (6) If you want to use RallySchool in RBR then tick a checkbox in "Replace School Car
files (slot 5)" option. If you want to use QuickRally or RBR_RX plugin then this option is
not necessary. Also you may need to disable the "Rally School menu replacement”
option in NGPcarmenu settings. (Main menu > options > plugins > NGPcarmenu)

e (7) Finally press "Apply" button on the bottom right corner and then you are ready to
drive with a NGP6 compatible car in RallySchool/QuickRally/RBR_RX. Notice! One more
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thing. Go to RallySchool/QuickRally/rbr_rx right after booting up RBR. Once you drive a
stage via RSF plugin then these legacy menus are broken until you restart RBR.

Q: QuickRally menu doesn't work (game crashes) or cannot see all cars and stages.

A: Forget the legacy QuickRally offline rallying RBR menu (it has only 8 cars and about 30
stages). Go to Options/Plugins/Rallysimfans.hu and use the Practice menu to drive stages in
offline mode. RSF plugin allows you to use all 85+ cars and 400+ stages (created by talented
people in RBR community).

Common error messages.

1):

REBRwr error

Unable to init QeenWVR runtime:

Installation path coula not be locatea (119)

Abort Retry lgnore

A: You have the VR plugin installed but no VR headset is found. If you're trying to play without
VR, apply VR mode on and then off in the RSF Launcher.

2):
Microsoft Visual C++ Runtime Library >

I.-f"_"“-.l Runtime Error!
— Program: EX\RER'\Richard Burns Rally
teszt\RichardBurnsRally_55E.exe

This application has requested the Runtime to terminate it in
an unusual way.

Please contact the application’s support team for more
information.

A: Missing or faulty stage files. Reinstall the stage. Could also be related to car physics.
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Links

Rallysimfans plugin website: http://www.rallysimfans.hu/rbr/in

Discord Server of Rallysimfans.hu: https://discord.gg/pQ4vJvR

Discord Server of RBR Zone (more general, not just RSF Plugin):
https://discord.com/invite/ATk42e8

Discord Server of FMOD sounds creation: https://discord.ga/yXYR2WvSqd
Discord Server of RBR Track Building: https://discord.gg/NeW2cGATpk

Vauhtimurot troubleshooting and install guide: https://vauhtimurot.blogspot.com/p/in-english.html
Skins and other mods: http://rbrplus.blogspot.com/

Skin templates: https://rbrtemplates.blogspot.com/
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